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About this Guide

This is the Getting Started Guide for CC MIS (NTP 297-2671-175). This
guide should be used in conjunction with other NTPs issued in support of
CC MIS.

This guide is intended to be used by supervisors who are new to the CC MIS
product. It provides these users with the basic steps and information needed
to gain quick access to all of the major functions available to a supervisor
terminal.

This guide is intended to provide a quick overview of the CC MIS Supervi-
sor’s interface. For a more detailed explanation of CC MIS functions, refer
to theCC MIS Supervisor’s Guide, NTP 297-2671-340.

This guide does not cover the System Administration functions. Information
concerning the use of these functions is presented in theCC MIS Supervi-
sor’s Guide, NTP 297-2671-340.

The images in this guide were captured from the CC MIS Release 3.2 prod-
uct running in Windows 95. If you are running the Text interface or Win-
dows 3.1, the screens will have a different appearance than those shown in
this guide. However, the basic functionality remains the same.

audience and scopeaudience and scope

Images in this guideimages in this guide
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Windows Basics
  Introduction

This chapter provides information on using the mouse, windows, and menus
when running the CC MIS windows interface.

  Using the mouse
The mouse is a tool that is used to select menu options and fields on the
screen. In essence, the mouse allows you to simply point and click to make
a selection. The mouse shown in the illustration in the figure below is a three
button mouse.

The names of the buttons are: left, middle, and right. The mouse button des-
ignations are: left = MB1, middle = MB2, and right = MB3. Most of the
steps in this guide refer to the mouse designations (for example, click MB1
on the... ).

 How to begin
If you are new to using a Windows interface, you need to
become familiar with this environment. You should
proceed through each section in this chapter. You should
also complete the Windows tutorial which is accessed
from the Help menu on the Program Manager window
(Start button in Windows 95).

If you have used the Windows interface and are already famil-
iar with pulldown menus and mouse operations, you can skip
this chapter.

In Windows, menu options are selected from pulldown menus.
Screens can be sized and multiple screens can be displayed at
the same time. A mouse can be used (instead of the keyboard)
to select fields and menu items. These topics are discussed in
the following paragraphs.

?

11
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 Key terms
Procedures in this guide are presented in steps. Within these steps you may
be instructed to double-click MB1 or press MB1 and drag the mouse.
When using a mouse you will need to know the terms listed below:

Pressing- Pushing and holding down a mouse button

Clicking - Quickly pressing and releasing the mouse button

Dragging - Pressing a mouse button while moving the mouse

Moving - Moving the mouse without pressing a button

Releasing- Letting go of the mouse button

Double-Clicking - Quickly pressing and releasing the mouse button twice

A Windows term you need to know is:

Focus- The area or window on the display that is active to input

 Mouse cursor

Three button mouse

left

MB1

middle right

MB2 MB3

Two Button Mouse: Button designations on a two button mouse are: Left (MB1)
and Right (MB2). MB3 is not used in CC MIS.

The mouse has a cursor (pointer) that indicates its position on the screen.
This mouse cursor is displayed in the shape of an arrow (for exam-
ple,              ). When the mouse is moved, the mouse cursor moves in the
same direction across the screen.
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 Screen layout and components
Screens in the Windows interface may contain a title bar, menu bar, window
menu button, help button, maximize and minimize buttons, and workspace.
A typical CC MIS screen layout and components are shown below.

Description of components

The following descriptions refer to the components identified in Figure 1-2.

Title Bar - Contains the title of the window. Click MB1 in this area of
the screen to bring this window to the front (move in focus).

Menu Bar - Contains the menu buttons (names) for this window. Click
MB1 on a menu button to view the associated pulldown
menu and options.
(Note: Not all screens have menus.)

To select a field using the mouse:

1. Move the mouse cursor to the field to be
    selected.

2. With the cursor position over the desired field,
    click MB1.

3. The cursor is now located within the selected
    field.

steps Selecting a field with the mouse

Screen layout

Menu Bar
with File, Edit,
Preferences, View, and
Help menu buttons

Windows Control Menu button Window Title Bar

Exit button

Minimize
button

Maximize
button

Workspace
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Help - Click MB1 on the Help menu button to view Help
information.

Window menu - This menu is used to effect the screen properties (such as
size) and for moving the screen. This menu is also known as
the Control menu.

Minimize - Click on this button to iconify the window.
Maximize - Click on this button to increase the size of the screen

 to fill the entire display area.

Workspace - The area where the data is displayed and inputs are made.

 Using scroll bars
Scroll bars allow you to view data that may be hidden due to the limitations
of a screen size. This happens when the contents of the screen are larger than
the screen itself. When this occurs, scroll bars appear on the display to allow
you to gain access to the hidden information.

By pressing MB1 on the arrow on top of the scroll bar, the contents of the
screen move downward until the first line or portion of the screen is dis-
played. (Clicking, instead of pressing, the mouse causes the information to
move one step.)

Pressing MB1 on the bottom arrow causes the data in the Workspace of the
screen to move upwards, revealing hidden data.

The components of a scroll bar are shown in below.

Scroll bars

Moves the
data down
to display the
first line

indicates
current
 position

 Moves the
 data upwards
 to display the
 last line

 Slider:

 Up Scroll Arrow:

 Down Scroll Arrow:

 Vertical Scroll
   Bar

 Horizontal Scroll Bar

(also known
 as the Thumb)
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 Viewing pulldown menus
Commands and options are selected from pulldown menus. These menus
are displayed by clicking MB1 on the associated menu button.

Selection from menu bar

The menu bar contains menu titles. When present, the selection of a menu
title causes an associated pulldown menu to appear. The pulldown menu
contains commands and available options.

The menu bar, menu titles, and pulldown menu are shown below.

Selection from within screen (workspace menu button)

Some of the Configuration Control windows in CC MIS have menu buttons
located within the workspace of the screen. Selecting the menu title results
in an associated pulldown menu being displayed. This type of pulldown
usually contains valid entries or ranges for a particular field.

The workspace menu button and pulldown menu are shown below.

Viewing pulldown menus

Click MB1 on
the File menu
title

The File pulldown
menu is displayed

from Menu Bar

Viewing workspace
Click MB1 on
the Menu
button

Highlight an
option on the
menu

pulldown menus
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 Cascade menus
Some menu items have an right arrow next to the option name. This indi-
cates that selection of this option will result in a second (cascade) menu be-
ing displayed. An example of a cascade menu is shown below.

 Keyboard accelerators
Some menu items have accelerators next to the option name. Accelerators
are key sequences that can be entered from the keyboard to execute that op-
tion or command. In CC MIS, most keyboard accelerators are the under-
lined letters (for example, on theAdmin button, the accelerator isA).
                        _____________________________

           Pressing the Alt key on your keyboard
and the A key displays the Admin drop
down menu.

                 ___________________________________

 Dialog box
Some menu items have three periods next to the option name. This indicates
that selection of this option will result in a dialog box or secondary screen
being displayed. Dialog boxes are used to provide the additional informa-
tion to the user and require a response in the form of clicking on an OK or
Cancel button. Some dialog boxes request the user to input additional infor-
mation or to select an item.

 Tool Bar
A tool bar appears on some of the screens in CC MIS. The icons in the tool
bar serve as short cuts to access menu functions.

Cascade menus

    Help

 Modify

Previous

 Next

     AddUndo

Revert

Print

Delete
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Online Help Screens
  Introduction

Help is available from any window within the CC MIS. The help systems
provides information about using the CC MIS product and its screens to per-
form functions.

 Accessing the help function

The steps listed below explain how to enter the Help function.

 Help options
There are three options: Help Topics, Window, and Using Help. The figure
below shows the Help menu selected on the CC MIS Main menu.

The three help options are described below.

1. On the CC MIS Main window, select Help / Index .

2. The index window for the Help function appears.

steps How to enter the Help function

Help menu

22
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Help Topics

Selection of the Help Topics option causes the screen in the figure below to
appear.This window contains a listing of all of the Help topics available for
CC MIS. Help topics are nested. Double-click on one of the options and ad-
ditional topics related to the one selected are listed under that topic. Select
a sub-topic and a help screen appears containing information on that topic.

Window

Selecting the Window option from the Help menu causes a screen to appear
containing information specific to the window currently displayed on your
terminal. An example of this screen is shown below.

Help
index
screen

Select a
  topic

Additional
Sub-topics
are displayed

Select a
topic and the
help screen
is displayed

Help
on
window
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Using Help

Selecting the Using Help option from the Help menu causes a screen to ap-
pear containing information concerning the procedures specific to the func-
tion that is opened. An example of this screen is shown below.

This screen provides access to information on how to use the Windows help
function. It also allows for the customization of the help screens.

Using
Help
screen



Online Help Screens

CC MISCC MIS

Page 2-4               CC MIS Getting Started Guide (297-2671-175)

Release 3.2



CC MIS Getting Started Guide (297-2671-175) Page 3-1

Logging into CC MIS

CC MISCC MIS
Release 3.2

Logging into CC MIS
  Introduction

This chapter provides information on logging in and out of CC MIS.

A key step in learning to use CC MIS is learning how to log in and log out of
the supervisor terminal.

 Logging in
Supervisors with profiles established in CC MIS can log in to any supervisor
position. Only one session per supervisor ID can run at a time. If you are
logged into one position and you try to log in at a different position, you
must either override your original login, causing the CC MIS system to log
you out of the original session; or cancel your login attempt and return to the
position at which you are already logged in.  The steps below guide you
through the login onto the CC MIS terminal.

The steps are explained in detail in the paragraphs that follow.

Starting at the program group,

1. Double-click on the CC MIS icon.

2. Then, from the CC MIS Main window, click on
    Session  and select Login.

3. The Login window appears.

4. Enter your supervisor ID [and password if
    required].

5. Identify your preferences, then click on the
    OK button.

steps Logging in to CC MIS

33
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Double-click on the CC MIS icon

After MS Windows is running on your PC, a window containing the CC
MIS icon should be accessible from the Program Manager on your display.
Open the CC MIS program group. The first step to logging in is to double-
click MB1 on the CC MIS icon.

This action is shown below.

Click on Session and select Login option

After the CC MIS Main window appears, click on the Session menu button
and select the Login option. The Session pulldown menu is shown below.

Enter supervisor ID and password (as required)

The CC MIS Login screen is displayed. Enter the supervisor ID (and pass-
word if required). Click on the OK button.

Note: In Release 3.1, the last supervisor ID entered is kept after logging out
of CC MIS. Therefore, if you are logging back into a terminal you had
logged into previously (and you do not have a password) you can press the
Return key. If a password is required, press the Tab key to tab to the Pass-
word field.

Clicking on CC MIS
 icon

Double-click MB1 on
the CC MIS icon in the Call
Center MIS program group CC MIS Main window appears

Selecting the Login option
from Session pulldown
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CC MIS Main window is displayed

The CC MIS Main window is displayed after successful login.

 Logging out

To logout from your session, use the steps listed below.

CC MIS login
screen

Preferences allows you
to select the settings
to be used for displays
(profiles and colors).

CC MIS Main
window

1. Return to the main window.

2. Select Session / Logout.

3. The CC MIS session is ended.

steps Logging out of CC MIS
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 When the system goes down
If CC MIS goes down, your session terminates. In this instance, the Connec-
tion Status icon border goes from green (operational) to red (non-operation-
al), and the message, Host Process Terminated, displays.

When the system comes back up, the Connection Status icon goes from red
to green. However, the message, Host Process Terminated, continues to dis-
play. The message explains the need to log in to supervisors who may have
been away from their terminal when the system went down.

 Exiting CC MIS

To exit CC MIS, use the steps listed below.

From the CC MIS Main window.

1. Select Session / Exit .

2. The CC MIS window disappears.

steps Exiting CC MIS
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 Defining communications (Terminal Setup screen)
The communication parameters are defined at installation. Should you need
to redefine these parameters you can do so by accessing the Terminal Setup
screen. You access the Terminal Setup screen using the steps below to ac-
cess the terminal setup screen.

1. Return to the CC MIS Main window.

2. Click on Session  and select Setup/
    Communications

3. The Communications Parameters window appears.

Refer to the CC MIS Supervisor’s Guide for communication
field descriptions.

4. Enter changes.

5. Click on the OK button.

steps Accessing communication parameters
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CC MIS Main Functions
  Introduction

This chapter introduces you to the functions that are accessed from the
 from the CC MIS Main window.

The CC MIS Main window is shown in the figure below.

 Displays menu
The Display menu contains commands to enter into Agent Status and Queue
Statistics displays. Click on the Displays menu button to display the Dis-
plays menu.

CC MIS Main
 window

Displays menu

44
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 Reports menu
The Reports menu contains commands for the CC MIS Reporting function.

 Config menu
The Config menu contains commands for the Configuration Control
function.

 Profile menu
The Profile menu contains commands for setting a supervisor’s profile.

Reports menu

Config menu

Profile menu
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 Admin menu
The Admin menu contains commands used by the system administrator to
administer control over the CC MIS environment. Admin options are not
covered in this guide.

Admin menu
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Agent Status Display

  Introduction
The Agent Status display provides information about the status of each
position in an ACD group.  This display allows the supervisor to see the
type of call the agent is currently handling, the agents that are logged in,
the agents on walkaway, and others.

 Accessing the Agent Status display
Perform the following steps to access the Agent Status display.

 Agent Status display
The Agent Status display allows you to control the view of the positions for
which agent status is displayed, the information presented for each position,
and layout of the display. The Agent Status display is shown below.

steps Accessing the Agent Status display

1. From the CC MIS Main window, select Displays  /
Agent Status .

2. From the Agent Status Display menu, select one of
    the views from the View pulldown menu.

3. The Agent Status screen is displayed.

55
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Agent Status display field descriptions

The following defines the fields that can appear on the Agent Status display.

Field Description

ACD GROUP The ACD group that is being viewed.

POSN The position ID of the physical phone set.
Note: Clicking on an agent position ID results in a
temporary agent detail window being displayed.

STATUS The state of the position.

                                       Note:This field is highlighted if it exceeds
           the threshold.

DURATIONS Available only in the Windows interface. Real-time
timer that indicates the time period (in minutes and
seconds) that the agent has been in the current state.

AGENT NAME The name of the agent logged into the position.

LOGIN Displayed when the login option is selected from the
Preferences menu. This field displays the time of day the
agent logged in. This field is always displayed in the right
most column.

Agent Status
display
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 Setting the view
You can select one of three possible views through the Agent Status View
menu: Subgroup, Scope, and Global. Views available to supervisors are de-
termined by the access provided by the system administrator when creating
your profile.

Your default view

You set the default view in your profile. CC MIS uses this view when you
first login and access your Agent Status display. The default can be either
subgroup/group, scope, or global. During a session, you can change this de-
fault to another view. You will see the change by logging out of the current
session and logging back into CC MIS.

 Additional capabilities provided by the Windows interface
The Windows interface allows you to control the fonts used for displays, the
information provided in the Agent Status Display, and the layout of the dis-
play.

Selecting fonts for the displays

The Windows interface allows you to select fonts for the displays. You iden-
tify the font used in the display through the Preferences menu. You identify
the font, font style, and size.

Controlling the information presented in the display

You identify the information to appear for each position in the group
through the Preferences menu.  You can select States, Names, Hold Time,
Durations, or Login Times, or desired combinations of these selections.  If
you do not select States, the color in which the position number appears in-
dicates the state of the position.  You define the colors for each state through
the Preferences / Color  menu item.

Showing elapsed time for agent positions

The CC MIS system tracks the length of time an agent position spends in
each state.  To view this information in the Agent Status display, select the
Duration option from the Preferences menu. This field is always displayed
in the Agent Detail window (accessed by clicking on the agent position) and
on Agent Status display printouts.

Hold Time

The Hold Time option is selected from the Preferences menu.  The Hold
Time option affects the way the time is displayed in the Duration field.
When enabled, each time the ACD or DN call is placed on hold, the timer
resets and begins counting. An underline ( _ ) is used to differentiate hold
time from total ACD or DN call time. After the hold state is terminated, the
timer reverts to displaying the total call duration.
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 ACD Group detail window
The Windows interface also allows you to display a permanent ACD Group
Detail window by positioning the cursor on an ACD Group ID in the Agent
Status window and clicking the right mouse button.

 Miscellaneous display functions
Printing the displays

While in a display, perform the following steps to print the display.
The display prints on the default printer.

Clearing the displays

While in a display, follow the steps below to clear the display
from your screen.

Selecting colors and fonts for displays

You can set the colors and fonts for the elements of a display.

Saving Preferences

You can set preferences for fonts and colors, then save the settings for the
display.

Monitoring another supervisor

You can observe the displays of another supervisor if you have the Display
option Monitor selected in your Privilege Level definition.  This feature is
useful to supervisors when a peer is absent from their workstation and some-
one else must monitor the activity of the agents and queue for which the
supervisor is responsible.

Note: When monitoring another supervisor’s display in scope view, the
display will be limited to the scope restrictions of the supervisor ID you
are monitoring. (This is transparent if both you and the supervisor you are
monitoring have a global scope restriction.)

ACD Group
display
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 Agent Detail window

The Windows interface allows you to display a permanent Agent Detail
window by positioning the cursor on an agent position ID in the Agent Sta-
tus window and single-clicking the right mouse button. The figure below
shows an example of the Agent Detail window with the Options menu dis-
played. The selection of one of these options changes the content and layout
of the detail screen.

Note: The Agent Status window can be temporarily displayed by pressing
and holding the left mouse button.

ACD Group
display



Agent Status Display

CC MISCC MIS

Page 5-6               CC MIS Getting Started Guide (297-2671-175)

Release 3.2



CC MIS Getting Started Guide (297-2671-175) Page 6-1

Queue Statistics Display

CC MISCC MIS
Release 3.2

Queue Statistics Display

  Introduction
The Queue Statistics display provides information about the
efficiency with which an ACD group is handling calls.

  Accessing the Queue Statistics display
Perform the steps to access the default Queue Statistics display.
The Default Display field of your profile determines the format of the
Queue Statistics display.

The System Administrator determines the default when creating your pro-
file.  If you have access to your profile, you can change the default.

The Queue Statistics display (with one of many views) is shown in the
figure below.

steps Accessing the Queue Statistics display

1. From the CC MIS Main window, select Displays  /
Queue Statistics .

2. The default Queue Statistics screen is displayed.
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 Changing or controlling the Queue Statistics display
There are three things you can change or control when using the Queue
Statistics display:

• the groups on which statistics are displayed
• the format in which statistics are displayed

When using the Queue Statistics display, you can control

• groups by setting the view to Single Group, Scope, Global, or New ACD
Group; or if enabled in your privilege level definition, monitoring another
supervisor

• format by setting it to one of the four standard formats, a personal format or
a public format

Setting the view

You can select a view from the View menu. Depending upon your scope
settings, the following views may be available:

• Single Group
• Scope
• Global

Additional views (such as New Subgroup) may also be available depending
on you access privileges. Access privileges are provided by the System
Administrator.

Queue Statistics
display
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Your default view

You set the default view in your profile.  CC MIS uses this view when you
first login and access your Queue Statistics display. The default can be
either supervisor, group, subgroup/group, scope, or global.  During a ses-
sion, you can change this default to another view.  You will see the change
by logging out of your current session and logging back in.

Note:  In order to access a group view, you must have a group member list
defined in your profile. To access global view it must be enabled in your
profile.

Controlling the format

The format of the display refers to the manner in which the statistics are pre-
sented, tabular or graphic.  Unlike the Agent Status display, the Queue Sta-
tistics display can be customized. Therefore, you can create formats in
addition to the standard formats provided with the system.  By customizing
the display, you select the statistics presented in the display, add meaningful
names to the statistics, and choose whether to display the information in tab-
ular or graphic format.

Changing the display format without changing the default

While you are in a session, you can change the format temporarily; that is,
changing the format until you logout, or change the format again. You
change the format through theView / New Display Format command.
If you change the display format without changing the default, and you lo-
gout, CC MIS reverts to your default Queue Statistics display when you es-
tablish another session.

Accessing Configuration Control

To access Configuration Control while you are in the Queue Statistics
display, you must have one or more of the Configuration Control options
that pertain to ACD groups enabled in your privilege level definition.  This
feature allows you to change ACD group parameters using multiple
windows on  your screen.  You access the Queue Statistics display in one
window, and access the Configuration Control functions in another
window.
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 Creating your own Queue Statistics display
You can create your own Queue Statistics display to identify the informa-
tion presented in the display and its location on the screen.  In order to create
your own personal Queue Statistics display, you must have the Display
option Personal formats selected in your privilege level.  This option allows
you to create, modify, and delete personal display formats using the Quad-
rant Definition and Screen Definition modes.

Note: Your supervisor privilege level must be set to allow you to define for-
mulas, modify public quadrants, and define public screens. The Display op-
tion Formulas selected in your privilege level. If a system admin password
is defined, you must enter the password to access admin functions.

Overview of the process

There are three basic steps to creating your own Queue Statistics display;
defining formulas, defining quadrants, and defining screens.  The following
paragraphs describe the basic process of creating your own Queue Statistics
display.

Step 1: Defining formulas

First you define any formulas you need to collect the data you want in your
display.  However, you do not need to create custom formulas;  you can use
any of the existing statistics collected by CC MIS.

Step 2: Defining quadrants

In this step, you define the way the information will be presented in a quad-
rant. There are two quadrant sizes:  full and half screen.  There are two types
of layout: tabular and graphic.

You have the option of using public quadrants, defined by system adminis-
trators, or using your own quadrants.  When you create your own quadrant,
it can be saved as personal or public.  You can define a total of five personal
quadrants.

Step 3: Defining screens

In this step, you name your display, and position the quadrants in the dis-
play. You have the option of using public screen definitions or using your
own. When you create your own screen definition, it can be saved as
personal or public. You can define up to five personal screens.
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steps Defining a quadrant

1. From the CC MIS Main window, select Displays  /
Quadrants .

2. Enter Custom Headings.
a.  Highlight the Custom Headings field (using the keyboard).
b.  Press the Edit field key.
c.  Type the headings for the data fields.
      Note:  Align the headings with the data fields.
d.  Press the End Editing key.

3. Enter Column Selections.
a.  Highlight the Column Selection field (using the keyboard).
b.  Press the Change field key.
c.  From the listing, highlight the appropriate data field.
d.  Repeat for each data field.
e.  Press the Finished key.

4. Enter the thresholds for the data fields.
a. Highlight the Thresholds field (using the keyboard).
b.  Press the Change field key.
c.  Highlight the first data field.
d.  Press the Options key and select the threshold.  If you select a constant
     threshold, you must also type the threshold value.
e. Repeat for each data field.
f.  Press the Finished key.

5. Save the quadrant
a. Press the [Commands] key and save the quadrant.
b.  Select Exit (without saving changes).
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 Defining graphic quadrants

Perform the steps below to define a graphic quadrant.

steps Defining a graphical quadrant

1. From the CC MIS Main window, select Displays  /
Quadrants .

2.The Display Quadrants screen is displayed.
Complete the following:
a. Enter the  Definition Name.
b. Specify a Quadrant Size (Half Screen or Full Screen).
c. Specify a Quadrant Style (Graphic). The screen changes to the

format shown in the figure below.

d. Specify the Number of Bar Segments (value 1 - 5).
e. Specify whether or not to display values (yes/no).
f.  Specify whether to display Bar Totals (yes/no).
g. Specify one of the following for the scaling method:
    Fixed, Floating, or Stepped.
h. If desired, in the Heading field, enter a one-line
    heading and modify the legend text.
i.  Select the formulas and color schemes using the  [Options] key for the
    Graphic Elements fields. (The F4 key only works when the field is empty.)

3. Save the quadrant.

4. Press Commands, then Save as a either a new
    personal or public quadrant.
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When finished defining the graphical quadrant, exit the screen by selecting
the Exit option from the File menu.

Saving your quadrant as a public or personal quadrant

Public quadrants are available to all supervisors, while personal quadrants
are available only to you.  Only System Administrators can assign the su-
pervisor the privilege level needed to create public quadrants. To create a
personal quadrant, save your definition as a personal quadrant using the
[Commands] menu. When defining a quadrant, the [Commands] menu pro-
vides the following functions as shortcuts:

- reading an existing quadrant
- undoing changes to quadrant
- overwrite an existing quadrant
- delete an existing quadrant
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 Defining a screen
After defining your quadrant, you position the quadrants on a screen.  The
size of a quadrant must be considered when placing the quadrant on the
screen.  Full screen quadrants can be placed only in either the upper or lower
left areas of the screen. Lower screen quadrants can be defined only if a
quadrant is placed above it.  In addition, the lower screen quadrant is option-
al.  If there is only an upper quadrant, the system automatically extends the
display to the bottom of the screen.

When you are defining a screen, you can use any standard quadrant, public
quadrant, or a personal quadrant (defined by you). There are predefined
standard quadrants available from the Options menu in the Screen Defini-
tion window. You can read an existing screen definition and modify it to
meet your needs.  You can also update an existing definition by overwriting
it.

steps Defining a screen

1. From the CC MIS Main window, select Displays  /
Screens .

2. Enter the Screen Name.

3. Press the Options key to select the quadrant.
    Repeat this step for each quadrant to be
    included in the screen.

4. Press the Commands key, and select Save as a
    New Personal Screen.

5. Select Exit (without saving changes).
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steps Viewing a custom display

1. From the Queue Statistics Display, select View /
    New Display format .

2. At the New Display Format? box, select the screen.

3. Click on ok.

steps Setting your default to a custom display

1. From the main window, select Profile / Options .
    The system displays the Profile Maintenance
    screen.

2. Select the default display (in the real-time display
    options area). At the Default Display screen, click
    on the down arrow to highlight your format.

3. Save the default settings.
a.  From the Profile Maintenance menu, select File / Validate to verify
     entries are valid.
b.  Select File / Save to save settings

4. Exit and implement changes immediately.
a.  From the Profile Maintenance menu, select File / Exit.
     A dialog box appears.
b.  Read the information box, and click Yes if you want the changes to
      be applied immediately. You will be logged off of CC MIS.
      Note: If you do not want to be logged out, click No.
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Wallboard Messages

  Introduction
Wallboards are LED message boards that are mounted on the walls of an
ACD group office. Supervisors use wallboards to notify agents of ACD sta-
tistical information and administrative information.  Supervisors construct
messages to suit their needs, define what messages are to be displayed, and
define time frames for displaying messages. Messages consist of text and
variable information such as Queue Statistics display formula results.

  Accessing the message screen
The Wallboard Message Definition screen allows supervisors to define the
actual messages that are displayed on the wallboard.

steps Access Wallboard Message Definition

1. From the CC MIS Main window, select Displays  /
Messages .

2. The Wallboard Message Definition screen is
    displayed.
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 The  display is show in the figure below.

Wallboard Message Definition screen fields

Message Text -Messages must not exceed 24 characters (this includes five
parameters that represent values from formulas). If a message exceeds 24
characters, the message is truncated.  This causes a partial message to ap-
pear on the wallboard. The character sequence <1>, <2>, ... <5> in the mes-
sage text refers to the variables.

Variables - Variables represent formulas that are based on real-time statis-
tical data collected by the system. Choose up to five formulas to display on
the wallboard. The formulas available on the wallboard are the Queue Sta-
tistics display formulas, 10-min window, 24 hour, and Shift statistics. Click
on the Down Arrow to view available options.

Display Format - The display format describes how the formula's value, if
it is time-based, is displayed on the wallboard. Click on the Down Arrow to
select a format. Depending on the variable selected, possible display for-
mats are:

1.  seconds
2.  minutes
3.  mm:ss
4.  hh:mm
5.  hh:mm:ss
6.  Numeric

Note:  You can only change the display format if the default format is a
time-based format.

Wallboard
message
definition
screen
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Defining a wallboard message

Use the following steps to define a wallboard message.

steps Defining a wallboard message

1. Select Displays/Messages from the CC MIS Main
    window. The Wallboard Message Definition screen
    is displayed.

2. Define the message:

a.   At the Wallboard Message Definition window, access the Message Text
       box.

b.  Enter the message to appear on the wallboard.  Enter variables as a
     number between 1 and 5, surrounded by <>.
     (Example:  Service Level <1> )

c.  If you entered a variable in your message, access the Variables box.

d.  Click on the down arrow to display a menu of variable choices.  Highlight
     your choice.

e.  For the variable, click on the down arrow in the Display Format box.
     Highlight your choice.

3. Save the definition:

a.  At the Wallboard Message Definition window, select File / Save.

b.  If the definition exists already, and you wish to update the definition,
     click OK on the information box.

If you are defining a new definition, click NEW at the Save Message
Definition As box.

Note:  CC MIS allows you to save multiple wallboard messages with the
same name. If you are modifying an existing wallboard message, save the
modification by using the Save command to prevent the system from saving
different wallboard message definitions with the same name.

4. Exit the screen by selecting File / Exit.
    The system returns to the main window.
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Clearing a wallboard

Wallboards always display a message.  Even when you power down the
wallboard and power it back up, the wallboard displays the last message sent
to it. You cannot send a blank message to a wallboard.

You may want to create a message that clears information from the display.
For example, you may send an asterisk (*) or dashes (- - -) to the display
to remove the previous message from the wallboard.

 Wallboard Display Definitions
Wallboard Display Definitions allow the supervisor to select the message(s)
to be displayed on the wallboard(s).

The Wallboard Display Definition screen is shown below.

steps Accessing the Wallboard Display

1. From the CC MIS Main window, select Displays  /
Wallboards .

2. The Wallboard Display Definition screen is
    displayed.

Wallboard
display definition
screen
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Wallboard Display Definition screen fields

(Language)- Defines the language in which the definition name is being en-
tered. ([Displayed only if Language Option has been purchased.]

Display Definition Name - Define a name that uniquely identifies the dis-
play definition. Use up to 40 characters in the name. CC MIS can save up to
250 display definitions.

Message - Select up to five messages to be displayed on the wallboard.
Click MB1 on the menu arrow to view a list of messages.

Scope - If the corresponding message contains variables then identify the
data source which corresponds to the message. If a selection is not made
from the pop-up menu then nothing appears (all ACD groups will apply).

Note:  In Profile Maintenance screen, if the ACD Group Names field is not
enabled, then the Scope pop-up menu lists the groups by DN instead of by
group names.

Seconds- Specify how long the message is to be displayed on the wallboard
before it is rotated. Choose from 2-999 seconds.

File menu options

The  File displays the following selections for the Wallboard Display Defi-
nition screen.

New
Open
Validate
Save
Save As
Delete
Send to Wallboards
Exit
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Defining  a wallboard display

After the display and message definitions are complete, the wallboard dis-
play is defined using the steps below.

steps Defining a wallboard display

1. From the main window, select Displays /
    Wallboards .

2. Enter information into the Wallboard Display
    Definition window:

a.  Access the Display Definition Name box and enter the name of the
     Display Definition.

b.  Click on the message entries and select one of the message definitions
      from the listing.

c.  Click on the first scope entry and identify the ACD group or All group for
     which any variables in the message are computed.

3. Save the definition as follows:

a.  At the Wallboard Message Definition window, select File / Save.

b.  If the definition exists already, click OK on the information box.

If this is a new definition, click NEW at the Save Message Definition As box.

4. Return to the main window by selecting File / Exit
    from  the Wallboard Display Definition window.
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Sending a message to the wallboard

Follow the steps below to send a message to the wallboard display(s).

steps Sending a message to the wallboard

1. From the main window, select Displays /
    Wallboards .

2. Read the wallboard definition.
a.  From the Wallboard Definition window, select File / Open .

b.  At the Open a Display Definition box, highlight the display definition
     you wish to send.

c.  Click Ok.

3. Send the message to the wallboard.

a.  From the Wallboard Definition window, select File / Send to
     Wallboards .

b.  At the Send to Wallboards box, highlight the specific wallboards

c.  Click on ok.

4. At the Wallboard Message Definition window,
    select File / Exit to return to the main window.
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Alarms (SNMP)

  Introduction
Note: The Alarms option is displayed only if the SNMP feature is enabled
and you have supervisor access privileges to this feature. Due to the techni-
cal nature of the SNMP feature, a background in network management and
the SNMP protocol is recommended for administrators and users of this
feature. For a more detailed explanation of this feature, refer to theCC MIS
Supervisor’s Guide, NTP 297-2671-340.

The Alarms Definition window is the starting point for all SNMP-related
activities at the partition level, including:

• alarm definition and maintenance,
• SNMP community setup and maintenance, and
• SNMP MIB file transfer

From this window, you can setup up to 100 custom statistics to be monitored
for each ACD group in the partition. The setup of each statistic includes
threshold and alarm information. The information defined for each Alarm
Definition is what is provided to a Network Management System (NMS)
when it queries for the CC MIS Partition MIB entries.

Use the steps below to access the Alarm Definition window.

steps Accessing the Alarms definition screen

1. From the CC MIS Main window, select Displays .

2. The Displays pulldown menu is displayed.

3. Select the Alarms  option.

4. The Alarms Definition window is displayed.
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The Alarms Definition screen is shown in the figure below.

 Description
The Alarm Definition window consists of four major components; tool bar,
status bar, form template and a definitions list.

Tool bar

The tool bar is the row of buttons across the top of the window which
provides shortcuts to many of the commands available on the window’s
menu. A tool-tip window is displayed for a short time when the mouse cur-
sor is positioned over one of the tool bar buttons. This window contains a
brief description of the function performed by the particular button.

Status bar

The status bar appears at the bottom of the window and consists of three sec-
tions. The first section indicates the number of records defined and the max-
imum number allowed. The second section indicates the number of records
currently selected in the definitions list. The third section is for displaying
status and progress messages.

Alarm
definition
screen

Form template
area

Tool bar

Status bar

Definitions
list

Print

Delete

Undo

Revert

Previous

 Next

     Add

 Modify

    SNMP
Community
    Setup  SNMP

   MIB
Transfer

    Help
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Form template

The form template consists of the fields in the top half of the screen which
are used for entering and modifying the fields which make up an alarm def-
inition. The definitions list in the bottom half of the screen displays a scrol-
lable list of currently defined alarm definitions. Any or all of the fields in
the definition may be displayed as a column in the definitions list. The only
restriction is that the ID column must always appear in the first column. As
columns are added or removed, the columns will automatically resize them-
selves to provide a best fit for the current width of the window.

The fields in this template are described below:

Alarm ID A unique alarm ID number in the range 1 to 100.

Alarm Name The name assigned to the alarm definition. This name can consist
of from 1 to 30 characters excluding the vertical bar character (|).

Formula The standard or custom formula used to compute the statistic value
upon which the alarm condition is based.

Threshold Level This field determines whether the computed value for the statistic
should cause an alarm condition if its value rises above or falls
below the threshold value defined for the alarm. The two possible
values for this field are Above or Below.

Threshold Type The type of threshold to apply to the statistic value. This can be any
of the available ACD group thresholds (as defined via Threshold
Definition) or the following special threshold type:

(Zero) - The threshold value is defined solely by the constant value
entered in the “Plus” field.

Plus This field defines a numeric value to be added to the value of the
ACD group threshold selected in the “Threshold Type” field to arrive
at the threshold value used for determining when the statistic value
indicates an alarm state. This constant component of the alarm
threshold can be any signed 32-bit number (-2,147,483,647
through 2,147,483,647).

Alarm Type This field determines the type of alarm (SNMP trap) to be generated
by this alarm definition. The four possibilities are: Poll, Minor, Major,
and Critical.

Alarm Delay This field sets a delay period in seconds from the time that an alarm
condition is first detected until the time that an SNMP trap is sent. If
the alarm condition clears within this delay period, no trap will be
sent. This delay value also applies to the clearing of an alarm
condition. The maximum delay value is 999 seconds.

Alarm Groups This field determines which ACD groups should cause traps to be
generated. The field will contain the names of all currently defined
ACD group lists (as defined in List Definition mode) and the special
“(All)” selection. If a list is selected, only the groups in the specified
list definition will cause traps to be generated. If “(All)” is selected,
all ACD groups will cause traps to be generated.
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The operation of the Alarm Definition window depends on the current mode
as indicated by the label on the button in the upper right corner of the win-
dow. The two modes of operation are modify and add. When the window is
entered, the initial mode is set to the add (if there are no alarm definitions
currently defined). Otherwise, it is set to the modify mode.

Use the steps below to add an alarm definition.

Note: For more information concerning adding or modifying an alarm def-
inition, select theHelp / Window option.

Use the steps below to modify an existing alarm definition.

steps Creating an Alarm definition

1. From the alarm window, select Options / Add
or click on the Add button.

2. Enter information into the Alarm Definition window.

3. Click on the Add button to send the definition to the
    database. The definition should now be listed in the
    list of alarm definitions.

steps Modifying an Alarm definition

1. From the alarm window, select an existing alarm
    definition from the list of Alarm Definitions.

2. Make the desired changes.

3. Click on the Modify button to send the changes to
    the database.

Note: To cancel the changes, click on the Revert
button (or select Edit/Revert ) before you click the
Modify button.
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 SNMP Community Setup

The SNMP Community Setup window is used to define the access rights for
Network Management Systems wishing to access the CC MIS Partition
MIB for this partition. This window is shown in the figure below.

This screen displays the current settings for each of the three communities
defined by CC MIS. When a CC MIS partition is created, the community
names are defaulted to “public”, “secure”, and “traps” for the read-only,
read-write, and traps communities respectively. The members list for the
read-only community will be set to 0.0.0.0, while the other two members
lists will be empty.

 SNMP MIB Transfer

The SNMP MIB Transfer window is used to download the CC MIS MIB
definition files to the local PC for use with a Network Management System.
These MIB definition files are text files which define all of the SNMP ob-
jects implemented by the CC MIS system.

SNMP

setup
screen

community

steps Accessing the Community Setup screen

1. From the Alarms Definition window, select
    SNMP/Community Setup .

2. The SNMP Community Setup window is displayed.
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The SNMP MIB Transfer window is shown in the figure below.

From this window you can select either the CC MIS Partition MIB or the
CC MIS System MIB to be downloaded. After you select the desired MIB
and click on the OK button, a Save As window is displayed.

Use the steps below to access the SNMP MIB Transfer screen.

SNMP

screen
MIB transfer

steps Accessing the SNMP MIB Transfer screen

1. From the Alarms Definition window, select
    SNMP/MIB Transfer .

2. The SNMP Community Setup window is displayed.



CC MIS Getting Started Guide (297-2671-175) Page 9-1

Reports

CC MISCC MIS
Release 3.2

Reports

  Introduction
The reporting feature of CC MIS provides you with the ability to print re-
ports:

• in one of five categories: standard, personal, public, system, and event log
• on a schedule and ad-hoc
• on paper or on your terminal

In addition, you can create reports that can be imported into commercial
spreadsheet packages.

  Accessing the reporting functions
Except for scheduling a report to print, reporting abilities are provided
through the Reports pulldown menu.

 Generating a report
With one exception, there are five steps involved in generating a report:

1. Identify the report format: tabular, graphic, or event log.
2. Identify the content of the data to be collected for the report.
3. Identify the type of report and its contents: printed report (data and totals)
   or data export report.
4. Identify the output device: printer or screen.
5. Request that the report be generated immediately (ad hoc report) or
    be scheduled to print.

steps Accessing the Reports menu

1. From the CC MIS Main window, select Reports .

2. The Reports pulldown menu is displayed.
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The exception is generating a system report.  System reports do not require
you to identify format, scope, or output device, as they provide pre-defined
information.

Identifying the report format

Report formats are either standard, event log, personal, or public.  The for-
mat identifies the data elements in the report.

Standard formats

The standard reports are formats provided by CC MIS. These formats
generate tabular and graphic reports.  The standard report formats are listed
at the end of this chapter.

Personal formats

Each supervisor can create five personal formats.  These formats are only
available to the supervisor who creates them.  Personal formats can be gen-
erated in tabular or graphic formats.  (Refer to theCC MIS Supervisor’s
Guide.)

Public formats

Supervisor’s with access to system administrator functions (Admin) can
create public formats for all supervisors to use. These formats can generate
tabular or graphic reports.

Identifying the format of the report

The format of the report refers to the following:

Time frame used to generate report
Time frame determines the granularity of the data reported and has to do
with the way data is stored in the historical database.  Possible time frames
are interval, shift, day, week, month, and period.

Manner in which the data is reported
- by logical group
- by data and totals
- by totals only
- by using secondary groupings through the Group by ... and by... feature
- the range to be used for the data elements specified in the report format.

The data elements can be defined as a single value or a range of values for

intervals             months
days                    periods
shifts                   agents
weeks

subgroups                  LOB codes
ACD groups               walkaway codes
ACD-DNs                    logical groups
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Identify the type of report

When you identify the type of report, you either create a printed report or
a data export report.

 Generating a report
Creating a printed report

A printed report is a report that uses CC MIS to format the report.  You may
request reports that contain Totals Only or reports that contain Data and To-
tals.  The Totals Only reports are useful when you do not need to show sup-
porting information.

Creating a data export report

A data export report is a report that can be used by a commercial spreadsheet
software package.  By creating a data export report, you create a file of data
records that is output to a printer or a PC.  The file lists the title of the
report and contains detail data only; it does not contain column headings nor
column totals.   When you generate a report, you can print it or have the out-
put sent to your terminal for display.

Printing reports

When you print a report, you can direct it to a specific printer or to the
default printer defined in your profile.  A different printer may be defined
for graphic or tabular reports.  If you have the local print feature, the print
goes to your local printer.

Viewing reports at your terminal

When you select screen as your output device, the report goes to your ter-
minal. After it is complete, it may be viewed by double-clicking the report
status icon on the Main window.

Note: You may need to size the viewing box so you can see the report in its
entirety.

Requesting the report

After you define the report format, the scope of the data, and the output de-
vice, you may request the report, or if you have system administrator abili-
ties, schedule the report.

Scheduling a report for printing

After you define the report, the report can be attached to a schedule and
printed at a later time. You must have access to system administrator (Ad-
min) abilities, schedule the report.

Note:Scheduled reports must have the print device set to a printer not to the
screen. Otherwise, the printing of the report defaults to the customer options
default printer.
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Defining report parameters

You define the format, scope, output device, and manner of presenting in-
formation through the Report Parameter Definition screen.  In this screen,
you are given the option to name the definition and use the name as the title
of the report.

The name of the report is used in menus to allow you to request the report
by name, rather than recreating the report parameter definition each time
you want to request the report.

Note:  Ensure that the name you assign to a report is unique. CC MIS allows
you to save multiple report parameter definitions with the same name.

The Report Parameter Definition screen is shown in the figure below.

steps Accessing Report Parameters screen

1. From the CC MIS Main window, select Reports/
Parameters .

2. The Report Parameter Definition screen is
    displayed.

Report
parameter
definition
screen
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Fields in the Report Parameter Definition screen

Name- This field identifies the report.  (The Use as Title button in this field
allows you to identify the name of the report as the title of the report.)

Format- This field identifies the category of the report, standard, public or
personal, and allows you to select a format in that category from a menu.
This field also identifies if the report is generated for Logical groups and by
Totals only.  Logical groups indicate reporting on several different groups
that are defined by one logical name.  Totals only results in leaving detail
out of the report and providing group totals only.

Note:  Icons indicate if the format is standard, public, or personal.

Time Frame-This field identifies the time frames for which data is collect-
ed.  This field determines the granularity of data.  Possible values are:  in-
tervals, shifts, days, weeks, periods, or months.

Logical Groups- This field indicates that you want the information grouped
logically; that is, information for several different groups (defined as logical
groups) summed together.

Group By And By - This field indicates secondary grouping, providing  sub-
totals according to the chosen criteria. Possible selections from menu (de-
pending on report) include: None, Shift, Day, Dst ACD Group, Logical
Group, and Subgroup.

Report Contents- This field identifies if the report provides group totals
only, or includes the detail supporting the total, or if it is data export.

Data Selections- This area defines ranges for data elements of the report
format. For each field, you can select one of the following:  All, Range, or
defined lists (in applicable key fields).  Interval and other time frame  fields
will also contain the Current and Previous selections.

Note: With Release 3.1, to select the previous time frame (such as interval
or day), you can select Previous rather than selecting Range then entering
a -1.

Global Data - This option allows a supervisor with the Global
View report option enabled to generate a report without any scope restric-
tion in effect.

Output Device -This field identifies the destination of the report.  Select the
output device type: screen, default printer, or specific printer.

Language of Report -This field identifies the language in which the report
is displayed. When the language option is present, you can select any avail-
able language (currently English or French). This is displayed only if the
Language Option has been purchased and enabled.
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Creating a report definition

Perform the steps below to create a Report Parameter Definition.

steps Creating a report definition

1. From the CC MIS Main window, select Reports/
    Parameters.

2. The Report Parameter Definition screen is
    displayed.

3. Fill in the Report Definition screen:
a.  Name your report and identify whether or not to use it as the title. This
      is optional. If a name is not entered then the Format name will be used.
b. Select the format of the report.  Click on the down arrow to select a

specific report type.
c. In the Report Contents, select the desired setting  by clicking on the
      down arrow and selecting the desired option.

Note:  The Logical Groups button sets data selection options.
d. Select your Time Frame.

Note:  The Time Frame button sets data selection options.
e. Select your Output Device.
f. Identify the grouping desired for the report.  To set a value, click on the

down arrow and select from your menu of  options.To clear a value,
highlight the value and press the Del key.

g. Identify your data selections.

Select All for all data items, Range to enter ranges, or another
     option (such as list, previous, or current), if  available for field.

4 Save the report parameters:
a.  Select File / Save.
b.  At the Save Report Definition As box, select the New Personal or
     New Public button.
c.  At the Definition Type screen, select either personal or public.
d.  The Save status screen will appear. Select OK.

5. From the Report Parameter Definition screen,
    select File / Exit.
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 Creating ad-hoc reports
By requesting a report, rather than scheduling it, you generate an ad-hoc
report.  To generate an ad-hoc report, you fill in the report parameters
on the Report Parameter Definition screen, and then request the report.

Determining report status

After you request an ad-hoc report that is to be sent to the screen,
the system notifies you that a report is gathering information or is pending.
The system notifies you of the status of the report  through the Report Status
icon on the CC MIS Main window.  The Report Pending status is indicated
by a report with an hour glass.

Viewing a report at your desktop

Once the report arrives on your desktop, you can view it.  This report re-
mains on your desktop until you delete it or request another soft copy report.
Use the steps below  to view your report.

Reports sent to printers cannot be viewed on your desktop and do not affect
a report that is at your desktop.

You can view a report on your screen, leaving the window containing the
report open, and request a different report through the Report Parameter
Screen.  If the second report is sent to your screen also, you will not be able
to view it until you close the window through which you viewed the first re-
port requested.

Note:  You may need to resize the window and use the scroll bars to view the
entire report.

Viewing the report parameters

Once a report has arrived at your desktop, you can view the report parame-
ters that created it, in addition to viewing the report.  To view the parame-
ters, view the report, then selectFile / View Parameters.

steps Viewing a report

1. From the CC MIS Main window, select Reports/
View or double-click on the Report icon.

2. The Report is displayed.
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 Generating a data export report
Generating a data export report is a simple matter of identifying Data Export
Report as the Report Contents at the Report Parameter Definition screen and
sending the report to an output device.

Note:  This is just the format of the report being specified. After the report
format is set, the report is sent to the output device. (Any report format can
be sent to a PC).

The report can be sent to any output device in your system that you can ac-
cess from the Report Parameter Definition screen.  If the device is a printer,
it prints a series of data records.  If the device is a PC designated to receive
files, it receives a software file that contains the series of data records.

You can generate a data export report from a PC running:

WCCMIS to another PC running WCCMIS

TCCMIS to a PC running WCCMIS

TCCMIS to a PC connected to the host and defined as a printer
(In this case, third party software is required on the PC that extracts data
from the serial connection.)

Viewing another supervisor's report

You can view another supervisor's report from your terminal, if that super-
visor has already requested the report, and the report is in their inbox.

steps Viewing another supervisor

1. From the display window, select Reports / Monitor
    View.

2.The system displays the Supervisor to Monitor?
   box. At the box, identify the supervisor, then click
   on OK.

 If a report is available, it appears on your screen.
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Generating an Event Log report

Event Log reports provide information about agent activities.  Refer to the
CC MIS Supervisor’s Guide for descriptions of these reports.  Use the steps
below to print an Event Log report.

Printing a system report

System reports provide information derived from the system database.  As a
result, they do not require that you define the report parameters for them.
The system reports are as follows:

• Configuration Report
• Supervisor Database Report
• Privilege Level Database Report
• Scope Database Report
• Agent Database Report
• Alarms Definitions Database Report
• ACD Group Database Report
• Threshold Definition Database Report
• Shift Definition Database Report
• Period Definition Database Report
• Schedules Definition Database Report
• Logical Group Database Report
• LOB Code Database Report
• Walkaway Code Database Report
• ACD-DN Database Report

These reports can only be printed; they cannot be viewed on your screen.
However, if the PC is set as the default printer, then the report will be sent
to the PC. You request these reports through the System Reports screen.

steps Printing an Event Log report

1. From the main window, select Reports /
    Parameters .

2. The system displays the Report Parameters screen.
     Identify your report parameters:

a.  At the format box, click on Event Log. Select your choice.

b.  At the Output Device box, select the device.

c.  At the Data Selection box,  provide the range for each data element.

d.  Select File / Print .

e.  Select File / Exit .
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Note:  There are three system reports that allow you to define the range
of the report.  They are the Supervisor Database Report, Agent Database Re-
port, and ACD Group Database Report.

 Custom formats
You can create personal (custom) tabular or graphic formats for a report.
Use the steps below to access the format screens.

steps Printing a system report

1. From the display window, select Reports / System
    Reports .

2. Identify the report.

a.  From the System Reports screen, click on the drop down box arrow.
     Select your report from the list of options.

b.  If prompted for additional information, select from your list of options.

3 Print the report.

a.  Press the [Commands] function key and select Print this report.

b.  Select Exit. (The system returns to the main window.)

steps Accessing custom formats

1. From the display window, select Reports / Tabular
    Formats or Reports / Graphic Formats .

2. The system displays the appropriate format screen.
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Tabular formats

The tabular report formats screen is used to define personal or public tabular
formats. Formats defined on this screen can be read into the Report Param-
eter Definition screen. The tabular report formats screen is shown below.

Field descriptions

Statistics Group- Specify the statistical group: Destination ACD-GRP,
Overflow, Agent, LOB Code, ACD-DN, or Walkaway statistics. Press F2
(Options) key and select the group.

Format Title- Specify the title for the format. The name entered in this field
will appear in other menus and serves as a default report title unless a report
title is specified in a report parameter definition. Accepts up to 55 charac-
ters. Enter the name or press F3 (Edit) to modify, then again when finished.
Custom Headings- Specify desired custom heading. The text entered in this
field(s) will appear on the report as headings above the data.

Column Selections- Specify desired statistics. Press F3 and use the arrow
keys to scroll menu. Select, then press Enter. Select again as desired or press
F3 to end editing.

Graphic formats

The graphic report formats screen is used to define personal or public graph-
ic formats. Formats defined and saved from this screen can be read into the
Report Parameter Definition screen. The graphic report formats screen is
shown below.

Tabular
report
format
screen
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Field descriptions

Statistics Group- Specify the statistical group: Destination ACD-GRP,
Overflow, Agent, LOB Code, ACD-DN, or Walkaway statistics. Press F2
(Options) key and select the statistics group.

Type of Chart- Specify the chart type for the graphic format. The screen is
redrawn with fields applicable to the type of chart selected (as shown be-
low).

After the type of chart is selected and the screen is redrawn, the graphic im-
age of the chart is displayed on the screen. As you complete each field, a red
bar appears on the graphic image to indicate where the information entered
in the field will appear on the chart. Information for each field is entered by
pressing the appropriate function key (such as F3 Edit). When finished,
press F1 (Commands) and save as a new personal format.

Graphic
report
format
screen

Selecting a chart type causes the screen
to be redrawn to contain fields applicable
to the type of chart selected.
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Printing custom reports
You can print personal (custom) tabular or graphic formats for a report.  Use
the steps below to print the format screens.

steps Printing custom reports

From the Main window:

1.  Select Reports / Parameters.

2. The system displays the Report Parameter
    Definition screen.

3. Select your custom format. Complete other fields
    (such as Name).

4. To print, select File / Print.

5. To save as a new personal report, select File /
    Save As , then select New Personal in the dialog
    box.
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Example of a report

The figure below provides an overview of how a report is defined by
identifying the CC MIS screens used to define a report.

Listing of standard report formats

The following tables provide a listing the standard report formats.

Table 1: Standard report formats

Standard Format Explanation

ACD Call Duration Identifies the duration of a call by measuring from when
the call is answered by the agent until the call is released
by the agent.

ACD-DN Calls Abandoned Identifies the total number of calls abandoned per ACD-
DN and the total abandon delay.

ACD-DN Calls Answered Identifies the total number of calls answered per ACD-DN
and the total answer delay.

ACD Group by Agent
Performance

Identifies agent activities for each group. This report can
tell if there is a problem with a particular agent or if all
agents are experiencing the same difficulties.

ACD Group by Agent
Transfer

Identifies agent transfer activities for each group.
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ACD Group by LOB Code Identifies the number and duration of calls by LOB
code for each group.

ACD Group by Walkaway

Code

Identifies the walkaway codes associated with a specific
ACD group.

ACD Group Overflow For each source and destination ACD group pair, indi-
cates the number of calls that either queue overflowed
(for example, due to exceeding maximum wait or queue
size) or time overflowed from the source to the destina-
tion.

ACD Group Transfer-In Identifies the number of calls that were transferred in to a
group.

ACD Group Transfer-Out Identifies the number of calls that were transferred out of
a group.

Agent Summary Provides detail regarding the types of calls received/
made and the amount of time spent for each agent.

Agent by ACD Group
Performance

Identifies the activities of all agents sorted by Agent ID
trough ACD group.

Agent by LOB Code Identifies the activities of all agents sorted by LOB codes.

Agent by Subgroup
Performance

Identifies the performance of each agent under  different
subgroups.

Delay Before Abandoning Identifies how many calls were abandoned and how long
the callers waited before they hung up.

Delay Before Answering Provides information about the service callers receive.

LOB Code by ACD Group Identifies call processing time for each LOB code. Breaks
down information to show which ACD group received the
calls associated with the LOB code.

LOB Code by Agent Identifies call processing time for each LOB code. Breaks
down information to show the LOB codes associated with
specific agents.

Summarized ACD-DN Call
Analysis

Identifies the ACD-DNs and summarizes the associated
call activity.

Summarized ACD Group Call
Analysis

Provides an overall analysis of an ACD group.  Shows
how calls were handled and maximum and average
delays and call durations.

Summarized ACD Group
Performance

Identifies groups in the system and summarizes group
load performance. It shows the actual number of calls
each group answered and the average time it took to han-
dle each call.

Summarized ACD Group
Transfer

Identifies the groups and summarizes transfer information
for the groups.

Table 1: Standard report formats

Standard Format Explanation
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Subgroup by Agent
Performance

Provides supervisors with performance information for
their agents.

Walkaway Code by ACD
Group

Identifies the reason for and the total time spent in  walk-
away state by an agent in a specific ACD group.

Table 2: Standard graphical reports

Standard Format Explanation

ACD Group Calls Abandoned
Graphic

For each ACD Group, shows how many calls were aban-
doned before and after receiving a recorded announce-
ment.

ACD Group Calls Answered
Delay Graphic

For each ACD group, shows how many calls were
answered before and after the delay objective.ACD
Group Calls Answered Delay Graphic

ACD-DN Calls Abandoned
Graphic

For each ACD-DN, shows how many calls were aban-
doned before and after receiving a recorded announce-
ment.

ACD-DN Calls Answered
Delay Graphic

For each ACD-DN, shows how many calls were
answered before and after the delay objective.

Table 1: Standard report formats

Standard Format Explanation
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Configuration Control

  Introduction
Configuration control allows you to view and adjust parameters inside the
ACD switch that relate to operating functions such as traffic control and
staffing.  CC MIS provides two modes of security that allows supervisors to
have control over access to Configuration Control screens and system
administration: Privilege Level Definition  and Scope Definition.

  Accessing configuration control functions
The CC MIS configuration control (load management) functions are access-
ed from the Config pulldown menu. The Config menu is selected on the
CC MIS Main window.

 Config menu
Upon successful login to the Supervisor Interface, the Supervisor's Main
window is displayed. Configuration Control functions (if privilege is set)
are accessed from the Main window by selecting Config.

steps Accessing the Config menu

1. From the CC MIS Main window, select Config .

2. The Config pulldown menu is displayed.

1010
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 Ad hoc Load Management screens
Ad hoc Load Management screens are screens you enter to make and exe-
cute immediate Load Management changes. The screens for Positions,
Groups, ACD-DNs, and Networking all follow the same format and have
the same available commands.

Screen functionality

 The following terms are used when describing the Configuration Control
screens:

Cell - A cell is a row and column location in the data portion of the screen.

Key field or column  - The left-most column of the data portion of the
screen is referred to as the key field or  key column.

Key  - The data (or type of data) that is in the left-most cell of any
row.

Null cell - The bottom cell that serves as a place holder to allow new cells
to be inserted. No data can be associated with this cell.

Configuration Control screens are initially displayed with a cursor posi-
tioned in the upper left corner cell  of the data portion of the screen. There
are five types of keys: ACD Groups, Positions, ACD-DNs, Agent IDs, and
ACD Group Pairs.

 Insert Dialog Box
The  Insert Dialog Box is displayed by selecting the Insert option from the
Edit menu or by pressing the Insert key on your keyboard. Keys and their
associated data are inserted into the screen by means of the Insert Dialog
Box. The contents of the Insert Dialog is dependent on the type of screen
currently displayed. The Insert Dialog Box is shown below.

Insert
dialog
box
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 Changing agent position assignments

This option allows you to view or change the supervisor and ACD group as-
signments of specified agent-positions.  The changes made in this option al-
ter Table KSETFEAT.

Note:  Asterisks (***) appearing in a field of a Configuration Control screen
indicates that the area can only be changed on the DMS-ACD switch.

Change Positions Assignments screen is shown below.

Show Changes

The default setting for this box is checked. This setting (indicated
by an checkmark) allows the user to see the changes made to any of the
fields on the screen. When the check indication is removed, the screen dis-
plays the
original data on the screen. (Changes made are still available even though
they are not displayed on the screen.) Click on the box (check it) to display
the changes.

Position Assignments screen fields

Position- Identifies an existing agent position ID. Use theEdit/Insert  op-
tion to insert positions. (Positions are up to 4 digits in length.)

ACD Group - Identifies the new ACD group to which the agent is to be as-
signed. Valid entries are the primary DN of an ACD group or ACD group
name.

Change
position
assignment
screen
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Subgroup - Identifies the subgroup identified by supervisor ID to which the
agent is to be assigned. (Range is 1-9999).

APR Subgroup - Identifies the Automatic Position Reassignment (APR)
subgroup of the current agent. This field is displayed only if the current sub-
group doesn't match the APR subgroup and APR is enabled in Customer
Options. (This field is displayed only if the APR feature has been purchased
and enabled.)

Current Agent- Displays the agent currently logged in to that position. No
input is accepted.

Moving an active position to a new group

Moving an active position to a new group will result in:

1. The real-time statistics will immediately reflect the agent's activity in the
    new group.

2. Call completion counts and durations will be pegged against the new
    group. LOB statistics will be pegged to the group/supervisor. (This may
    result in an undefined lob code for the new group.)
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 Changing agent set parameters
You can change the multi-stage queue threshold settings, the number of
display digits, the default line of business (LOB) code and the ACD group
wrap-up time for agent sets. Changes made alter Table ACDGRP.

The Agent Set Parameters screen is shown below

Note: An asterisk (***) appearing in a field of a Configuration Control
screen indicates that the field can only be changed at the DMS-ACD switch.

Agent Set Parameters screen fields

ACD Group -Identifies the name or DN number of an existing ACD group.
Accepts as input (using Edit/Insert) any existing ACD group name, ACD
group list name, or ACD group by its primary DN.

Multi-Stage Queue  Threshold Type - Identifies whether the Multi-Stage
Queue ranges are associated with call queue size or call wait time. The valid
values are QSize or WTime.

Multi-Stage Queue Threshold  - Identifies three threshold values represent-
ing indicators on agent sets. Each threshold depends on the threshold type
(either wait time or queue size).

Display Digits - This field specifies the number of digits displayed to agents
in the ACD group. The range is 0-10 and is selectable from a menu.

Default LOB - LOB means line-of-business code for the ACD group. A val-
id range is 0-999.

Agent set
parameter
screen



Configuration Control

CC MISCC MIS

Page 10-6           CC MIS Getting Started Guide (297-2671-175)

Release 3.2

Wrap-Up Time- The group wrap-up time defines the default amount of time
an agent is unavailable following the handling of an ACD call. (This is con-
sidered as agent not-ready time and is pegged as variable wrapup time and
shown as VARWRAP on Agent Status screen). A valid range is 1-600 sec-
onds.

Note:Agent wrap-up time will override the default wrapup time if it is
datafilled in the ACD Table ACDLOGIN or ACDENLOG.
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 Changing queue size parameters of an ACD group
This option lets you view or change the queue size parameters of specified
ACD groups. Changing fields in this option alters the Table ACDGRP.

The Queue Sizes screen is shown below.

Note:  An asterisk (***) appearing in a field of a Configuration Control
screen indicates that the field can be changed only at the DMS-ACD switch.

Queue Size screen fields

ACD Group - Identifies the name or DN number of an existing ACD group.
Accepts as input any existing ACD group name, or ACD Group list name.
Primary ACD-DNs may also be entered.

Maximum Calls - Identifies the maximum number of calls that can be
queued in this ACD group's incoming call queue at any one time.  Accepts
as input any number  from 0 to 511 inclusive.  A zero value means that this
ACD group does not have call queuing, but will route to the table specified
in either the Threshold Route or Overflow Targets fields in the Overflow
Targets screen.

Maximum Wait Time - Identifies the maximum number of seconds that a call
can be held in the incoming call queue before being answered by an agent.
Accepts as input any number from  0 to 1800 seconds.

Maximum Incoming Overflow - Identifies the maximum number of logical
calls that can be queued. Accepts as input any number from 0 to 511 inclu-
sive.

Queue
size
screen
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Maximum  Xfer - Identifies the maximum number of calls that can be trans-
ferred to agents in this ACD group.  Accepts as input any number from 0 to
42 inclusive.

Note:  The Call Transfer Queue Size is dependent on the maximum call
queue size for your group.  Normally, the range is 0 to 42, but if the maxi-
mum call queue size is set to less than 42, you cannot exceed that value.

Priority Promotion Timer -Identifies the maximum amount of time an un-
answered call can remain in a particular priority queue.  When the call ex-
ceeds this timer value, then it is promoted to the next higher priority queue.
Accepts as input any number from 0 to 255 inclusive.   A zero value means
that priority promotion time out does not apply.
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 Changing time overflow parameters of an ACD group

This option lets you view or change the time overflow parameters of speci-
fied ACD groups.  This option alters the Table ACDGRP.
The Time Overflow Parameters screen is shown below.

Note:  An asterisk (***) appearing in a field of a Configuration Control
screen indicates that the field can be changed only at the DMS-ACD switch.

Time Overflow screen fields

The Time Overflow screen contains the following fields:

ACD Group- Identifies the name or DN number of an existing ACD group.
Accepts as input any existing ACD group name, or ACD group list name.
Primary ACD-DNs can be used.

Priority  0  Only - Identifies that only priority 0 calls have time delay over-
flow. Accepts as input either yes or no.  If no, then all calls have time delay
overflow.

Immediate Timer- Identifies that timing for time delay overflow starts as
soon as calls are received. Accepts as input either yes or no.

Time Delay Threshold- Identifies the time delay overflow threshold that is
applied to either all calls or priority 0 calls only. Accepts as input  0 to 1800
inclusive.

Time
overflow
parameters
screen
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Service Order - Identifies the order in which the call queues are serviced.
Accepts as values:

0 = Outflow calls, then inflow calls, then calls queued within
      priority

1 = Outflow calls, then priority 0 calls, then inflow calls,
      then other calls queued within priority

2 = Oldest call of either the physical or logical queue

Time Delay Threshold Time -Identifies the amount of time in seconds a time
delay overflowed call remains in queue before being rerouted to the Time
Delay Threshold Route. Accepts as input 0 to 1800.

Threshold Route-Identifies the route used for rerouting time delay over-
flow calls. Accepts as input Table OFRT or IBNRTE and 0 to 1023.
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 Changing the overflow targets for an ACD group
This option lets you view or change the overflow targets of specified ACD
groups. The changes made in this option alters Table ACDGRP.

The Overflow Targets screen is shown below.

Overflow Targets screen fields

ACD Group- Identifies the name or DN number of an existing ACD group.
Accepts as input any existing ACD group name, or ACD group list name.
Primary ACD-DNs can be used.

Overflow Targets- Identifies up to four targets to enhance overflow.  Ac-
cepts the primary DN of an ACD group or a group name as input.

Threshold Route-Identifies the route used for rerouting time delay over-
flow calls.

Overflow
targets
screen
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 Changing recorded announcements parameters - ACD group
This option lets you view or change parameters for the recorded announce-
ments (RAN) of specified ACD groups.  The changes made in this option
alters the Tables ACDGRP and AUDIO.

Recorded Announcements screen is shown below.

Recorded Announcements screen fields

ACD Group  - Identifies the name or DN number of an existing ACD group.
Accepts as input any existing  ACD group name or ACD group list name
using theEdit / Insert  option. Primary ACD-DNs can be used.

Threshold - Identifies how long the incoming call waits in queue before re-
ceiving a recorded announcement.  If this value is 0, then the caller receives
an announcement immediately upon entering the incoming call queue for
this ACD Group and does not receive a ring (RINGING field in table  ACD
Group  = No).  Accepts as input 0, 6-60.

Audio Group - Identifies the audio group, which  in turn identifies the choic-
es (MUSIC, SILENCE, ANN, and REPEAT), and the number of times
these recorded announcement choices should play to queued calls in this
ACD group.  If the existing value in the Audio Group field is 0, then the
DMS-ACD does not have a defined audio group for the related ACD group.
Accepts as input 1-512.

Forced Incoming - Identifies the audio group to be used to give forced in-
coming announcements to new incoming ACD calls. Accepts as input: 1 -
512.

Forced Overflow- Identifies the audio group to be used to give forced over-
flow announcements for deflected ACD calls. Accepts as input 1-512.

Recorded
announcements
screen
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Provide Announcements - Specifies if the ACD group should provide forced
incoming announcements and delay announcements for calls overflowing
into this group. Indicate Yes or No. (This specifies which announcement the
caller will hear: either those from the original group called or from the group
to which the caller is overflowed.)
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 Changing special routing parameters for an ACD group
This option lets you view or change the night service and control interflow
parameters of specified ACD groups.  The changes made in this option al-
ters Table ACDGRP.
ACD activates the night service feature when all agents in an ACD group
have logged off their set.  All calls residing in the incoming call queue at this
time remain in queue (unless call queue clearing ACD feature is active)  un-
til the caller disconnects, but no new incoming calls are received by this
ACD group.  The supervisor can activate the night service and controlled in-
terflow features.

The Special Routing screen is shown below.

Special Routing option screen fields

ACD Group - Identifies the name of an existing ACD group.  Accepts as in-
put any existing ACD group name or ACD group list name using theEdit /
Insert option.  Primary ACD-DNs can be used.

Night Service Route- Identifies a table name and an index number to which
this ACD group routes night service calls.  Accepts as input either OFRT or
IBNRTE and an existing index number.

Night Service Group - Identifies the Audio Group is used to provide a night
service announcement  to callers prior to rerouting the call to the night ser-
vice route. Accepts as input 1-512.

Controlled Interflow Route - Identifies the route the calls will take when the
supervisor has put the group into controlled interflow mode. Values for this
field are tables OFRT and IBNRTE and index ranges 0-1023.

Special
routing
screen
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 Changing network parameters for an ACD group

This option lets you change various parameters that are used in networking
ACD groups (NACD) together. The changes made in this option alters Ta-
ble NACDGRP.

The Network parameters screen is shown below.

Note:  An asterisk (*) appearing in a field of a Configuration Control screen
indicates that the field can be changed only at the DMS-ACD switch.

Network Parameters option screen fields

ACD Group -This field identifies the name or number of the ACD Group.
Primary ACD-DNs can be displayed in this field.

Call Threshold - This field can change the queue threshold with a range of
0-511.

Wait Threshold - This field can change the maximum wait threshold with a
range of 0-1800.

Preference Weighting Factor - This field shows the group preference
weight factor with a range of 0-32767.

Most Idle Agent - This is the factor used in calculating the Resource Index
for the group with a range of 0-600.

Num Idle Agent  - This is the factor used in calculating the Resource Index
for the group with a range of 0-255.

Network
parameters
screen
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Service Rate - This is the average service rate (call handling time) for the
group with a range of 0-600.

Consider Source - This field specifies whether the source group should be
considered when determining the best target group for time overflow calls.
The values are Yes or No.
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 Changing ACD-DN assignments and priorities
This option lets you change trunk priorities for specified ACD-DNs, the
line priorities of primary DNs, the group assignments of supplementary
DNs and the name of the ACD-DN.  The changes made in this option alters
the Tables DNROUTE and DNATTRS.

The Change ACD-DNs Assignments and Priorities screen is shown below.

ACD-DNs screen fields

ACD-DN- Identifies the existing ACD-DN number.  Accepts as input any
existing ACD-DN number or ACD-DN list name using theEdit / Insert  op-
tion.

DN Type - Identifies the DN as a primary or supplementary DN.  Each ACD
group receives calls from up to 17 ACD-DNs.  Within each ACD group
there is one primary and up to 16 supplementary ACD-DNs.  This field does
not accept input.

Priority - Trunk - Identifies the priority for ACD calls coming in over
trunks.  Accepts as input 0 to 3 inclusive, where 0 is the highest  priority and
3 is the lowest priority.

Priority - Line  - Identifies the priority for ACD calls coming in over lines
or for ACD calls originated from within the same switch. Accepts as input
0 to 3 inclusive, where 0 is the highest  priority and 3 is the lowest priority.
The field is left blank and is not accessible if  the DN type is Supplementary.

ACD-DN
assignments
and priorities
screen
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ACD Group- Identifies the name or number of an existing ACD group that
processes calls for this ACD DN.  Accepts as input any existing ACD group
name or ACD Primary DN.

Name - Identifies the name of the ACD-DN. Accepts input as 15 character
or less. This name is not used by CC MIS.
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 Changing network targets

This option lets you set the Preference Weight Factor for networked ACD
groups. (You can also set the Resource Index for networked groups on non-
DMS switches.) The changes made in this option alters Tables NACDGRP
and REMNACD.

The Network Targets screen is shown below.

Network Targets option screen fields

Source/Destination ACD Group Pair - This field identifies the destination
ACD groups that are network targets of  the source ACD group. There can
be a total of 48 destination groups per source ACD group.

Preference Weighting Factor - This field allows you to change the Prefer-
ence Weight Factor for  the source / destination ACD group pair.  The range
of this field is 0-32767.

Resource Index Value - This is the current Resource Index for the destina-
tion ACD group.  (This is a display only field.)

Network
targets
screen
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 Using Configuration Control efficiently
Configuration Control has several features that allow you to use configura-
tion control efficiently.  These features are:

• defining change orders rather than ad hoc requests
• defining lists
• viewing the transaction log

 You define change orders to:

    - schedule the changes
    - initiate several changes on one schedule
    - define changes you use frequently

When you define a change order, you group a set of Configuration Control
changes together and reference them by the change order name. You have
the option to either execute these change orders immediately or schedule the
changes for execution at either a later date and time or at recurring intervals.

Note: CC MIS allows you to save multiple change orders with the same
name.  If you are modifying an existing change order, use the Overwrite an
existing change order command to prevent the system from saving different
change orders with the same name.

The Change Orders screen is shown below.

Use theView/Transaction Log andView/Execution Queue to monitor the
status of your cahnges.

Note:  You must have System Administrator abilities (access to Admin) to
schedule the change order.

Change
orders
screen
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 Viewing Configuration Control database tables
You can view the data tables through the Config/View or View menus.

Configuration Control database tables

Route List -Displays the route list for all ACD Groups in the current con-
figuration. After the initial screen displays, you can use the page-up and
page-down keys or scroll bar to scroll through the table.

Audio List -Displays the audio list for all ACD Groups in the current con-
figuration. After the initial screen displays, you can use the page-up and
page-down keys or scroll bar to scroll through the table.

OFRT Table -Displays all defined entries in the OFRT table. After the ini-
tial screen displays, you can use the page-up and page-down keys to scroll
through the table. (See the following Supported Routes and Supported Se-
lectors.)

IBNRTE Table - Displays all defined entries in the IBNRTE table. After the
initial screen displays, you can  use the page-up and page-down keys to
scroll through the table. (See the following Supported Routes and Supported
Selectors.)

Audio Table - Displays all defined ACD entries in the Audio table.  After
the initial screen displays, you can use the page-up and page-down keys to
scroll through the table.
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Printing Reports
The reporting feature of CC MIS provides the ability
to print reports:
a). in one of five categories (standard, personal,
     public, system, and event log)
b). on a schedule and ad-hoc
c). on paper or terminal

Note:  Scheduling and terminal viewing does not
           apply to system reports.

Report Parameter Definition Screen
Select Reports then the  Parameters option. There

Printing an Ad-hoc Report
From the Report Parameter Definition screen, select
File  then the Open  option.

are five steps in generating a report.

1. Highlight report format and click OK.
2. Print the report using File/Print .
3. Click OK.

1. Identify report format.
2. identify scope of data for report.
3. Identify report and its contents.
4. Identify output device.
5. Request report to be printed or scheduled.
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Configuration Control
Configuration Control  allows you to view and adjust
parameters inside the ACD switch that relate to
operating functions such as traffic control and staffing.

Accessing Configuration Control
Depending on your privilege level and scope definition,
you can perform the following functions. From the
Config menu (on Main window) select:

1. Positions to change agent positions.
2. Groups  to change ACD groups or network
    parameters.
3. ACD DNs  to change ACD DNs.
4. Networking to change Network Targets and
    limitations.
5. Change Order to create or change  change orders.
6. View/Transaction Log to view configuration
     transactions.
7. View/APR List  to view APR failures.
8. View/Execution Queue to view requests.
9. View/ (table name) to view the desired database
    table.

Quick Start with CC MIS
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